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Understanding Apple’s Marginalization of the Mac
by Adam C. Engst  

If you’ve been feeling as though Apple’s heart isn’t in moving the Mac forward these days, you’re not 
alone. The new MacBook Pro models have taken widespread criticism, Apple has provided no roadmap 
for the future of its desktop Macs, and most recently, the company eliminated the position of Product 
Manager of Automation Technologies, presumably seeing it as unnecessary. High-end creatives have 
despaired about Apple’s lack of attention to their needs, and the mood among many of the consultants 
and support professionals at last week’s MacTech Conference was downbeat.

So what could explain Apple’s increasing marginalization of the Mac, particularly in the pro market? 
The culprit is clearly the iOS platform, and the iPhone in particular. But the reason why it’s happening 
has more to do with a structural fact about the company that Apple will have to change if the Mac is to 
get the attention it needs to thrive.

For better and worse, Steve Jobs burned focus into Apple’s DNA. When Jobs returned to Apple in 
1996, he focused the entire company on the Mac, slashing projects like the Newton and eliminating the 
Mac clone licensing program. Famously, he limited the Mac line to just four core models: the iBook and 
iMac for consumers, and the PowerBook and Power Mac for professionals. That product matrix was 
simple, clean, and understandable, and it was probably the only reason that Apple survived that era. 
Focusing on one platform was essential.

Here’s the problem: Despite the fact that it now employs 115,000 people and is the most valuable 
company in the world, Apple still thinks like a one-platform company. Now it’s all about iOS, and 
everything Apple does is designed to serve the single goal of selling more iPhones and iPads. Sure, the 
Apple Watch and Apple TV might seem separate, but they’re not. The Apple Watch is an iPhone 
accessory that makes the iPhone more attractive, and Apple TV apps generally have iOS counterparts. 
Heck, both watchOS and tvOS are basically custom versions of iOS. Apple’s online services, from iCloud 
to the App Store to the iTunes Store, all support the shared ecosystem, which encourages platform 
lock-in.

How does the Mac fit into this new world order? It plays well with iCloud and the iTunes Store, and it 
increasingly taps iCloud for added functionality. It’s another link in the chain that keeps users buying 
iPhones and iPads because it’s easier to have a computer that talks to your smartphone and tablet 
seamlessly. The Mac also remains essential to iOS as a development platform, and (through macOS 
Server) as an organization-wide caching server for iOS and app updates. In essence, the Mac is an 
accessory to the iOS platform.

But that’s it. If you’re an architect who relies on AutoCAD on the Mac to design buildings, or a video 
editor who spends your days in Adobe Premiere and After Effects, or a photographer who works in 
Photoshop and Lightroom, you care primarily about what the Mac enables you do to as a Mac, not as an 
adjunct to iOS. You might be a huge fan of your iPhone and iPad, but the Mac is what enables you to 
earn your bread and butter.

Before iOS, Apple’s goals and the needs of professional Mac users were more aligned. Apple wanted to 
make the Macs — and versions of the Mac operating system — that would give users capabilities and 
efficiencies they couldn’t get from PCs running Windows. That goal also informed Apple’s relationship 
with developers, since Apple had a vested interest in supporting software companies whose apps made the 
Mac attractive to different professions.
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Announcements

NO SIG  MEETING IN DECEMBER

Club dues increase to $30 starting January 1, 2017
Due to declining revenue and increased costs, SMMUG will be raising its dues for the first time since 
its inception in 1985! Dues will go up by $5.00 to $30.00 for Regular and Dual memberships effective January 1, 2017. We are doing this to 
continue to provide our membership with value as we move forward. Members enjoy the following benefits to name a few: 

• Monthly instruction and review of current hardware/software and issues relevant to the Apple Mac OS, iOS, Watch OS, AppleTV OS at 
General Meetings and Special Interest Groups (SIGs) 

• Excellent monthly newsletter with relevant articles 
• Website to connect members, offer timely bargains and tips, etc. 
• One large incentive prize per year and monthly door prizes 
• At least one industry leading Guest Speaker per year 
• One-on-one problem solving during monthly networking breaks and SIGs 
• Annual pizza party 
• An opportunity to socialize with other members in an era when many User Groups have disbanded 

Special incentive: If you join or renew your membership before January 1, 2017, you can enjoy all the benefits of membership for another calendar 
year at the present rate of $25.00! 

2017 Elections for the SMMUG Officers and Board of Directors
We will be electing our 2017 SMMUG Board of Directors at our Annual Meeting on December 12, 2016.   All positions are open. We will be 
electing the following for 2017:
• The President manages the day to day operations of the Corporation, in accordance with these bylaws and direction from the Board.
• The Vice President who will in the absence of the President, perform the President's duties and other duties as assigned.
• The Secretary records and reports the minutes of Board Meetings.
• The Treasurer maintains the corporate financial and membership records and report the financial and membership status to the Board and 

Members on periodic basis and perform other duties as assigned.
• Directors-at-Large (up to six (6) positions available)

Door Prizes For The December Meeting:
3 copies of Airy (software)

Club News
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Now that Apple’s primary task is to sell more iPhones, the company has little incentive to improve the Mac past the point that iOS developers 

need to run Xcode and macOS Server’s caching server effectively. Sure, the Mac business was worth $22.8 billion in revenues in 2016, which is far 
from chump change, but it’s nothing compared to the $192.8 billion of revenues generated by iOS and associated services.

When you look at the notable changes in the Mac operating system in the last five or six years, many of them are more about making the Mac 
experience more like the iPhone and iPad experience. Consider Siri, Picture in Picture, Split View, and Launchpad. And then there are Photos, 
Contacts, Calendar, and Mail, all of which are nearly identical across platforms. Even the iWork apps like Pages, Keynote, and Numbers have 
changed not to become better Mac apps, but to work more like and in tandem with their iOS cousins. The entire point of Handoff, arguably, is to 
make the Mac more of an accessory for iOS, handing off tasks to an iPhone so the user can leave the Mac or transferring something from the iPhone 
to the Mac to take advantage of a keyboard and large screen.

Plus, Apple has started to drop Mac accessories that it previously thought were important to the overall Mac experience. The 27-inch 
Thunderbolt Display fell by the wayside earlier this year (see “Apple Discontinues Thunderbolt Display with No Replacement in Sight,” 27 
June 2016), and if the rumors are correct, Apple has disbanded the AirPort division.

Don’t misunderstand me. Apple’s focus on iOS has been insanely successful, generating unimaginable amounts of money and taking the 
company from the “critically acclaimed” category to “mainstream blockbuster.” I’m not criticizing that success, or the method that Apple used to get 
there.

However, I am troubled by what it means for the future of the Mac as a general purpose, user-focused computer. The relative success of the iPad 
Pro, with its Smart Keyboard and Apple Pencil, suggests that Apple wants to push iOS toward the productivity market. Even app development is 
moving in that direction — the Swift Playgrounds app for learning to program exists only on the iPad (see “Playing Around with Swift on the 
iPad,” 13 June 2016). The writing would appear to be on the wall for the Mac — I can’t see Apple killing it off anytime soon, but benign neglect 
will have the same effect in professional markets, as developers weigh their options and direct more effort toward Windows. And that in turn will 
cause Mac sales to drop and Apple to be even less interested.

Steve Jobs said, “If you don’t cannibalize yourself, someone else will.” That was appropriate when killing off the iPod with the iPhone, but 
assuming that the iPad can supplant the Mac would be a mistake, I believe. Unlike the iPod, which was a subset of the iPhone, there are many 
things we can accomplish on a Mac that would be difficult or completely impossible on any iOS device. Apple seems to be under the incorrect 
impression that, for whatever you might want to do, there’s an iOS app for that.

The future doesn’t have to play out this way. In fact, Apple has shown that it’s capable of breaking free of the focus on a single product in the past. 
That’s where the iPod came from, and without the iPod, it’s unclear if Apple would have come up with the iPad and iPhone. Focus is good, but it 
can be taken too far, and that’s what I’d argue is happening at Apple right now.

Instead, Apple could take FileMaker Inc. as a model. FileMaker, which emerged from the ashes of Claris, is a wholly owned subsidiary, but since 
the needs of the database development market differ significantly from those of Apple’s other markets, it has presumably made sense to give 
FileMaker more autonomy than other apps. Even if FileMaker’s independence is a historical accident — I don’t know what sets it apart from Final 
Cut Pro or Logic Pro, which Apple has kept in-house — the point remains: Apple could give the Mac division its head rather than tying it to the 
iOS wagon.

Lots of corporate giants have divisions or subsidiaries that run largely independently, and I see no inherent reason why Apple couldn’t spin the 
Mac out just far enough that it could focus on the needs of Mac users, rather than merely trying to be supportive of iOS. That would apply to both 
Mac hardware and macOS, and yes, it would require significant coordination to ensure that Apple’s famed integration didn’t suffer in the process.

Hard though it might be, letting the Mac team pursue its own goals could result in a Mac that would once again indisputably be the computer of 
choice for creative professionals.

What Apple’s MacBook Lineup Should Look Like
by Adam C. Engst 

Complaints about the new MacBook Pro models abound, centering on the 16 GB RAM limit, the keyboard, the need for numerous adapters for 
its Thunderbolt 3 ports, and the lack of a MagSafe charging connector. (Many people have concerns about the Touch Bar too, but those are largely 
hypothetical; we won’t know whether it was a good addition until developers add support for it and users can see how well it works for them.) There 
are good explanations for why Apple made each of these design decisions, but they all come down to optimizing for size, weight, and battery life.

Going beyond 16 GB would have required a power-hungry chipset that would have reduced battery life significantly or called for a much larger 
and heavier battery. The keyboard feels the way it does — which some people hate — in part to take up less vertical space so the MacBook Pro can 
be thinner. And while Thunderbolt 3 has great technical specs, some of its appeal to Apple is also its use of thin USB-C ports that occupy less space 
— probably externally and internally — than a varied collection of ports.

In his closing talk at last week’s MacTech Conference, the inimitable Andy Ihnatko hit the nail on the head when he pointed out that despite the 
different names, the MacBook, the MacBook Air, and the MacBook Pro are all really just variants on the MacBook Air concept. They’re thin, light, 
and relatively expensive for what they offer in terms of performance and connectivity. That’s fine, but not everyone wants the smallest and lightest 
Mac laptop. For some, price is paramount, and for others, performance matters most.

http://tidbits.com/article/16586
http://tidbits.com/article/16586
https://www.bloomberg.com/news/articles/2016-11-21/apple-said-to-abandon-development-of-wireless-routers-ivs0ssec
https://www.bloomberg.com/news/articles/2016-11-21/apple-said-to-abandon-development-of-wireless-routers-ivs0ssec
http://tidbits.com/article/16570
http://tidbits.com/article/16570
http://tidbits.com/article/16570
http://tidbits.com/article/16570
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A more compelling line of Mac laptops might look like this:

• MacBook: The canonical MacBook should be rugged and inexpensive, with low-end performance and connectivity options. Remember the 
white and black plastic MacBooks? A machine worthy of the MacBook name should channel those design goals and be ideal for a high school 
student. Size and weight are somewhat important, but price should be the driving factor, ideally starting around $500 for a 13-inch non-Retina 
model with 4 GB of RAM and 128 GB of flash storage. Give it two USB-A ports, a MagSafe charger, and a Mini DisplayPort jack — there’s no 
need to raise the cost with USB-C or Thunderbolt. Let’s see Apple innovate on price for once.

• MacBook Air: The ideal MacBook Air would be much like today’s 12-inch MacBook, with two Thunderbolt 3 ports instead of a single USB-C 
port because… duh. Size and weight are supreme with this machine, and while performance doesn’t need to be stunning, it should be comparable 
to or better than the proposed MacBook. The price can go up, and options for 16 GB of RAM and larger SSDs should be available. The target 
market for such a MacBook Air is the busy executive who travels constantly but doesn’t need much beyond email, Web, and Microsoft Office. 
Pricing might start at $1200.

• MacBook Pro: For power users, Apple should optimize the theoretical MacBook Pro for performance and connectivity, worrying about size, 
weight, and battery life secondarily. A 13-inch model might have similar performance specs to a tricked-out version of the proposed MacBook Air 
but with an industrial design that offers more ports: MagSafe, Thunderbolt 3, Thunderbolt 2 port, USB-A, HDMI, Ethernet, and an SD card 
slot. Its price might start around $1500 and go up with additional CPU and storage. For those who need the ultimate power, the 15-inch model 
could support amounts of RAM above what laptop chipsets can generally handle, along with a plethora of build-to-order options that could push 
its price from a starting point of maybe $1800 into the stratosphere. Such specs would reduce battery life and increase weight but would enable 
mobile professionals to rely on a single machine.
The core problem is that Apple no longer seems to understand how Mac users choose their machines. Right now, it’s nearly impossible to figure 

out what Mac laptop to buy, because the three key differentiators of price, size, and performance are difficult to tease out, with all the models 
converging on the MacBook Air’s focus on size at the expense of price and performance.

Plus, as Andy Ihnatko also pointed out, Apple has become a design and manufacturing company, not an engineering company. Unsurprisingly, 
the only Mac for which design and manufacturing matter more than anything else is the canonical MacBook Air, which needs to be magically small 
and light and is willing to compromise on price and performance.

The prime directive of an engineering company is to provide products that solve users’ problems. It’s all about helping users achieve their goals with 
the least amount of wasted time and effort. That used to describe Apple to a T.

Nowadays, Apple is ignoring the desires of many Mac users and focusing on making gorgeous objects that are possible purely because of the 
company’s leadership in advanced manufacturing techniques. That has a place with an iPhone or iPad, but who cares if an iMac is thin? You look at 
the front, not the edge! We don’t mind if our Macs are carved from single blocks of aluminum and feature chamfered edges, but that design won’t 
make us more productive. (For more on why Apple is doing this, see “Understanding Apple’s Marginalization of the Mac,” 21 November 2016.)

When it comes to Macs, form should follow function, not force us into uncomfortable compromises.

Touch Screens, Touch Bars, and the Single Point of Focus
by Michael E. Cohen

Let’s take a trip on Mr. Peabody’s WABAC Machine back to 1984 to look at the first Macintosh. The huge change it introduced to the early 
consumer computer market was the shift from a screen filled with text that you navigated with cursor keys to a graphical display that you navigated 
with a pointing device. At the time, many thought the mouse was a gimmick.

It was a huge change, indeed: cursor keys and pointing devices are extremely different interface paradigms. However, both limit your interaction 
with what is on the screen to a single point of contact. For the text interface, it’s the text cursor; for the graphical interface it’s the mouse pointer. No 
matter what kind of data is on the screen, you can interact with it only at a single point.

That single point of contact, whether mouse or keyboard driven, has a significant drawback: travel time. When your cursor is at the bottom of a 
block of text and you have to hold down on the up arrow key to get it to the top line to fix a typo, or when you’re drawing in the middle of the screen 
and you have to move your mouse to the menu bar at the top of the screen to pull down a menu, the travel time involved takes you away from the 
current task, possibly hurting creative momentum. This isn’t a usability tragedy, but it is a drawback.

To mitigate the travel-time issue, engineers developed workarounds like the Page Up and Page Down keys, key combinations for traversing text, 
keyboard shortcuts for menu commands, and keyboards with function keys that could be programmed to perform various actions or multiple 
keystrokes. So-called “power users” (I’m looking at you, Adam!) adopted these workarounds quickly, and keyboard shortcuts remain in common use 
today.

Of course, such shortcuts have their own drawbacks: users must remember which function keys or key combinations do what. Even with some 
standards imposed (such as Command-X, Command-C, and Command-V always being assigned to the menu commands for Cut, Copy, and Paste 
on the Mac), users must still learn keyboard commands — they are not intrinsically intuitive.

There is one situation in which two points of focus have long existed on the Mac: text editing (and, by analogy, any editing situation that presents 
content in a linear sequence or timeline, such as audio or video editing). For example, you can select text, move the mouse pointer to a color setting 

http://tidbits.com/article/16914
http://tidbits.com/article/16914
https://en.wikipedia.org/wiki/WABAC_machine
https://en.wikipedia.org/wiki/WABAC_machine
http://fortune.com/2009/01/12/jan-1984-how-critics-reviewed-the-mac/
http://fortune.com/2009/01/12/jan-1984-how-critics-reviewed-the-mac/
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palette to change the selection’s color, and keep that palette focused under the mouse while, using the keyboard, you move the text cursor, select 
another range of text, allowing you just to click to change that selection’s color.

Nonetheless, travel time friction, and the related risk of momentarily losing your place in your content when you move your pointer to perform 
an action, is still a central part of the Mac experience.

A brief digression: what about multi-touch, Apple’s mouse-less graphical interface introduced in iOS? Multi-touch can reduce travel time friction 
and it can give you multiple points of focus on the screen, but it isn’t a panacea. For example, fingertips don’t save you from losing your place in your 
content: unless you have transparent hands, the very act of pointing at something hides the thing at which you are pointing. Nor is the memory 
burden created by memorizing function key and shortcut keys eliminated: in a multi-touch interface users have to remember the differences between 
a single and double tap, what two-finger taps do, which apps and which objects in those apps respond to 3D Touch, and so on.

The Touch Bar doesn’t completely solve the travel-time and loss-of-context drawbacks inherent in the traditional Mac experience, but it does 
address some of the problems introduced by previous workarounds. Take function keys: the Touch Bar’s dynamic context-driven display reduces 
the memory burden they present, assuming controls it presents are well-labeled.

More importantly, the Touch Bar essentially gives you a second point of focus for manipulating your content. It doesn’t just offer you contextual 
function-key-like buttons, but dynamic controls like sliders. You can, like a pianist or guitarist, play your Mac with two hands. Professional video 
editor Thomas Grove Harper describes the experience:

The first revelation for me was the potential of sliders. Gradual, precise and fast inputs. For years we’ve had single mouse inputs on a 
graphical user interface. Over time we’ve added more buttons and scroll wheels, trackpads with gestures. The Touch Bar takes this 
step further by allowing multiple inputs at 
the same time and combines well with the 
trackpad. The more I’ve used it the more 
I’ve replaced certain keyboard shortcuts. 
[…] It works, it’s faster, and it’s more 
productive.

Despite those glowing words, it is too early to 
come to any conclusions, pro or con. Developers 
are only gradually adapting their apps to take 
advantage of the Touch Bar and it will take time 
for developers to figure out all the ways in which 
they can exploit this new interface paradigm.

In terms of both its potential and usability, 
today’s Touch Bar is roughly where the mouse 
interface was on the 128K Mac. In addition, 
Apple offers it only to those who buy a MacBook 
Pro. As such, anyone who calls the Touch Bar 
“revolutionary” is overreaching. For that to stand 
a chance of happening, Apple needs to make it a 
standard part of the Mac experience for desktop 
Macs as well. Otherwise, it will remain a gimmick 
in the way that the 128K Mac’s mouse did not.

ExtraBITS
Netflix Introduces Offline Viewing for iOS -- 
Netflix now allows iOS users to download movies 
and TV shows for offline viewing. Josh Centers 
explains how.

Carpool-Kids Takes the Hassle out of 
Carpools -- School’s in session, which means kids 
need rides. Mike Matthews shares details about 
an app that can help parents team up to spread 
the driving duties.

http://www.huffingtonpost.co.uk/thomas-grove-carter/one-professionals-look-at_b_12894856.html
http://www.huffingtonpost.co.uk/thomas-grove-carter/one-professionals-look-at_b_12894856.html
https://9to5mac.com/2016/11/14/the-best-apps-for-macbook-pro-touch-bar-touch-id/
https://9to5mac.com/2016/11/14/the-best-apps-for-macbook-pro-touch-bar-touch-id/
https://9to5mac.com/2016/11/14/the-best-apps-for-macbook-pro-touch-bar-touch-id/
https://9to5mac.com/2016/11/14/the-best-apps-for-macbook-pro-touch-bar-touch-id/
http://tidbits.com/article/16924
http://tidbits.com/article/16924
http://tidbits.com/article/16929
http://tidbits.com/article/16929
http://tidbits.com/article/16929
http://tidbits.com/article/16929
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Can’t wait for the next newsletter to see what the guys and gals at Joy of Tech are up to? Then simply go on over to their 
website and see past and current cartoons and other things

http://www.joyoftech.com/joyoftech/
http://www.joyoftech.com/joyoftech/
http://www.joyoftech.com/joyoftech/
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How to Turn Off Sierra’s Optimized Storage
by Adam C. Engst

When first introducing macOS 10.12 Sierra, Apple made much of Optimized Storage, a marketing term that encompasses various settings and 
cloud-related technologies for moving data from a Mac’s space-constrained local drive to the cloud. In “Explaining Sierra’s Optimized Storage” 
(19 September 2016), I tried to lay out what Optimized Storage covers, explain the Storage Management window interface, and give suggestions 
about what you should or should not enable manually. Since Optimized Storage deletes data from your local drive such that it may not exist in your 
backups, you should be aware of the implications of turning it on.

Unfortunately, because Sierra prompts you to enable Desktop and Documents folder syncing during installation and may enable the associated 
Optimize Mac Storage checkbox by default as well, many Mac users are unwittingly enrolling important data in Optimized Storage. Worse, reports 
have started circulating that Sierra may have enabled some previously disabled Optimized Storage features during the 10.12.1 update. That’s 
not OK.

For the record, I don’t believe that Optimized Storage is inherently evil. Some of its options, such as deleting the local copies of watched movies 
and TV shows purchased from the iTunes Store, have few downsides. However, many people wish to maintain complete control over local storage, 
so I’ll explain how to disable all of Optimized Storage’s options in this article.

iCloud Drive & Desktop and Documents Folder Syncing -- Technically speaking, Desktop and Documents folder syncing isn’t part of 
Optimized Storage. Its goal is to store your documents in iCloud Drive 
so you can access them from any of your Apple devices.

However, Optimized Storage can apply to all iCloud Drive-based 
documents and data, including the Desktop and Documents folders if 
they’re being synced through iCloud. If Optimized Storage does decide 
to start deleting local files to free up space, those files are most likely to 
come from your Documents folder. To keep your Desktop and 
Documents folders out of iCloud, and to ensure that data that is in 
iCloud is always mirrored locally, open System Preferences > iCloud > 
iCloud Drive > Options, and deselect both Desktop & Documents 
Folders at the top of the list and the Optimize Mac Storage checkbox at 
the bottom.

Be aware that turning off Desktop and Documents folder syncing is 
stressful. When you do so, in System Preferences > iCloud > iCloud 
Drive > Options, Sierra tells you that all your files will be available only 

in iCloud, which seems wrong: if you’re turning off syncing, you’re 
doing so because you want them locally. However, that dialog is 
followed immediately by another that tells you that you can 
recover your files from iCloud Drive.
  In fact, what happens when you turn off that feature is that Sierra 
recreates empty Desktop and Documents folders in your home 
folder. You can’t replace those folders, so it’s not possible to drag 
the old Desktop and Documents folders from iCloud Drive to 
your home folder. Instead, you must open each folder in iCloud 
Drive and move (Command-drag) its contents to the new local 
Desktop and Documents folders in your home folder. You can try 
to delete the now-empty Desktop and Documents folders from 
iCloud Drive, but in my experience, iCloud keeps recreating at 

Macs & MacOS

http://tidbits.com/article/16765
http://tidbits.com/article/16765
https://9to5mac.com/2016/10/27/opinion-sierra-storage-management-system-nightmare/
https://9to5mac.com/2016/10/27/opinion-sierra-storage-management-system-nightmare/
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least the Desktop folder.           

Photos -- Given the ease of taking and storing photos and videos, your Photos library may occupy more space than anything else — I’m not a 
prolific photographer and mine is still over 110 GB. If you have multiple Apple devices, using iCloud Photo Library lets you access, edit, and manage 
your photos from any device, which is great, even if it almost always requires that you pay for additional iCloud Drive space.

iCloud Photo Library was one of the first places where Apple dipped its toes into optimizing storage because many Photos libraries are far too large 
to fit on iOS devices. Plus, it’s not uncommon for someone to have 
an iMac at home but want to play with photos on a 
space-constrained MacBook Air while on vacation.

My recommendation is to keep Optimized Storage enabled for 
all iOS devices and secondary Mac notebooks where space is at a 
premium, but to turn it off on your main Mac so your photos are 
always included in your backups. To do this, open Photos > 
Preferences > iCloud, and select “Download Originals to this 
Mac.”

Mail -- If you work with people who send around presentations 
or videos on a regular basis, Mail is likely consuming a significant 
amount of drive space. Email messages themselves are small, so 
there’s no win in deleting them, but attachments are another story.

In previous versions of Mail, you could either download all 
attachments or leave them all on your IMAP server. Sierra’s 
version of Mail adds a third option to download only recent email 
attachments. When you open a message whose attachment hasn’t 

been downloaded, you can click a button to get it. If you want 
to see how much space you’d save by downloading only recent 
attachments, launch System Information, choose Window > 
Storage Management, and click Mail in the sidebar.
  Apple has bundled these features into Optimized Storage, so if 
you want to make sure that your local mail archive always 
contains both messages and attachments, so in Mail, go to Mail 
> Preferences > Accounts > accountName > Account 
Information and choose All from the Download Attachments 
pop-up menu. Make sure to do this for each of your accounts!

  iTunes -- Video can consume massive amounts of 
drive space, but it’s also slow to download. If you 
regularly purchase movies and TV shows from the 
iTunes Store, you can use Optimized Storage to remove 
watched videos from iTunes automatically. But what if 
you’re buying content for a child who wants to watch 
things multiple times, or you want to ensure you can 
watch anything again without having to download again 
over a slow Internet connection?

To turn off Optimized Storage in iTunes and ensure 
that all the videos you purchase from the iTunes Store 
stick around even after you’ve watched them, navigate to iTunes > Preferences > Advanced and deselect the “Automatically delete watched movies 
and TV shows” checkbox.
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Empty Trash Automatically -- All the previously mentioned 

features of Optimized Storage involve deleting the local copy of a file 
under the assumption that it can be retrieved from the cloud if 
necessary. The final aspect of Optimized Storage that you might want 
to turn off is different — it’s an option in the Finder that automatically 
deletes files in the Trash after they have been there for 30 days.

Frankly, there should be no downside to enabling this option. You 
should never depend on being able to go into the Trash to bring back a 
file that you deleted more than a month before. Just don’t delete any 
file that you might want again.

That said, if you want more control over when your Trash is 
emptied, go to Finder > Preferences > Advanced and deselect “Remove 
items from the Trash after 30 days.”

  Manage Storage Manually -- If you’re uncomfortable with Optimized 
Storage but are still running out of space on your Mac’s drive, you can use the 

new Storage Management window to identify and delete large files. 
Open the System Information app, choose Window > Storage 
Management, and look at all the sidebar categories underneath 
Recommendations.

With a little attention paid to the old versions of apps, unnecessary 
downloads, and unexpectedly large documents scattered around your 
drive, you can often clear a surprising amount of space in just a few 
minutes while retaining complete control over your local storage.

Reuse governed by Creative Commons license. TidBITS has offered years of thoughtful commentary on Apple and Internet 
topics. For free email subscriptions and access to the entire TidBITS archive, visit www.tidbits.com.
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 Magic Bullet Suite 13
by L. Davenport

No matter how good/expensive your video camera is, there is always going to be video footage that isn’t perfect, such as too dark, too light, grainy, 
etc. There will also be times when you want to do color correction on your footage. That’s where the Magic Bullet Suite comes in handy. It has all of 
the professional color correction tools that you need to improve the look of your 
footage in one package. Plus, instead of having to export your footage to a 
program separate from your video editing tools, you can have these tools right 
inside your video editing program. 

The Magic Bullet Suite comes with a set of seven color correction and 
grading tools for Final Cut Pro, Motion, Premiere Pro, and After effects. All of 
the tools support OpenGL/OpenCL and are GPU Accelerated for maximum 
speed. Let’s take a quick look at each tool: 

Colorista IV
Colorista IV comes with a Guided Color Correction option (Figure 2). It 

takes you through 7 steps which when completed, gives you a well balanced 
shot that is ready for color grading. All of the corrections that you make are 
translated as settings in Colorist IV. So you can pick up directly where you left 
off. Here is a list of the Colorista IV tools (Figure 1) and a short description of 
each: 
• Auto Balance: This tool should be used first in your color correction process. 

It is a color picker that helps you to remove a highlight color cast by having 
you click on the whitest area in your clip. Afterward it will set a color that 
balances out the Red, Green and Blue components to make that white area 
neutral.

• 3-way Correction: When you apply Colorista IV to your clip, several tools 
appear in the Final Cut Pro Inspector. The first tool is: 3-Way Correction. 
This gives you three color wheels for Highlight, 
Midtone, and Shadow. 

1. The Highlight Wheel lets you set the white level 
in the footage. You can use it to brighten and tint 
the entire image or adjust the highlights.

2. The Midtone wheel changes the mid-tones in 
your footage, shifting the middle tones to be 
darker or brighter. So if you want to make your 
image more warm, just move the Midtone dot 
toward the yellow/red area of the wheel — the 
more you move to the outside of the wheel, the 
'warmer' the image becomes.

3. The Shadow wheel lets you set the black level in 
your footage. You add density or darkness when 
you move the Shadow color. You can raise or 
lower the Shadow levels with its Luminance 
control. You can offset the color balance in the 
Shadow regions with the Hue Point. Moving the 
controls toward any of the colored regions pushes 

Figure 2. Colorista IV includes a Guided Color correction option that takes you 
through 7 steps that gives you a well balanced shot that is ready for color grading 
BTW: this screenshot shows the 7th step - Color Balance.

Figure 1. These are the Colorista IV tools. They include the 
Shadow, Midtone, and Highlight color wheels (Top left), the 
Hue/Saturation and Hue/Lightness HSL Corrections wheels, 
along with a Curves tool and other color correction sliders.

Reviews
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the color balance toward that color, moving from unsaturated at the center to completely saturated color at the edge.
• HSL Correction (HSL stand for Hue, Saturation and Lightness): Colorista IV places a Saturation wheel and a Lightness wheel in the Inspector. 

You can use them to pick a color that you want to change and then it lets you move the Hue, Saturation, and Lightness controls to change it to 
another color. This tool is nice since you can change the hue and saturation of only one color at a time rather than changing the hue and 
saturation of the whole scene. For example, I was able to crank up the saturation on the green of some trees in my video without effecting the 
items behind the trees that were of a different color. It really made the trees “pop” out in the scene.

• Curves: The Curves control has four groups of Curve parameters (RGB, Red, Green, Blue) which gives you control over smooth contrast and 
color adjustments.
Keyer: The Keyer helps you isolate and adjust individual colors or ranges of colors. In other words, you can use it to fine-tune flesh tones, change 

color of your clothes, etc., from one color to another. When you click on the “Edit” button (in the Inspector) a whole new window opens up that 
shows the “Source”, “Matte”, and “Results” view panels. Off to the left of the window are the Color Cube and Vectorscope color selecting tools that 
are used to create your Key.  Once a key is created, all color correction affects the keyed area only.
• Vignette: This allows you to add vignetting which decreases the brightness around the edges of the frame.
• Mix: This controls the overall strength of your effect.
• Colorista IV now directly supports Log footage, with both specially-tuned log adjustments and built-in Look Up Tables for common Log 

formats.
• LUT (Look Up Table): LUTS are new to Magic Bullet. With them you can speed up the color grading process by importing your own LUTs or 

use one of the included LUT presets.  
If you would like to see Magic Bullet Looks being used, please click on this link to the 

Magic Bullet Colorista IV “Getting Started” video.

Looks
Magic Bullet Looks comes with 230 “Looks” presets that are designed to match the 

look of your favorite movies and TV shows. All of the presets are customizable, plus you 
can create a look from scratch by combining any of the Looks’ tools (Figure 3).

When you first apply Looks to your clip, an on-screen control appears. When clicked 
on, the Magic Bullet Looks interface/window opens up. At its center is the Preview 
window (showing your clip), on the left are all of the presets (represented by thumbnails 
of your clip), on the right are all of the Tools (each tool is represented by a box with a 
name and a graphic that shows what the tool does), and across the bottom is the Tool 
Chain (when a tool is applied, it appears in the Tool chain). 

All of the Looks presets are grouped into categories for quick retrieval. These categories 
include things like: Blockbuster, Color Film stock, Enhancements, Filters, Grading 

Figure 3.This is the Magic Bullet Looks window that pops up when you select the plug-in from Final Cut Pro.  

Figure 4. Cosmo II improves the look of your actors 
by removing skin blemishes, tweaking their skin 
tones, and reducing wrinkles.

http://www.redgiant.com/tutorial/magic-bullet-colorista-iv-quickstart-guide/
http://www.redgiant.com/tutorial/magic-bullet-colorista-iv-quickstart-guide/
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Setups, Grunge, Mono Film Stock, People, and Techniques. Placing your 
cursor over each of the presets instantly changes the preview of your clip to 
that Look. This is a quick way to find the needed look without having to 
actually apply the Look first.

There is a Favorites folder that is located at the top of the Looks Presets 
folders. This gives you immediate access to the presets that you use most 
often.

Looks comes with the ability to work with reference stills to inform color 
correction decisions. You can take snapshots to compare corrections between 
different clips or projects - or load stills from other sources.

If you would like to see Magic Bullet Looks being used, please click on this 
link to the Magic Bullet Looks “Getting Started” video.

Film
“Film” changes the look of your footage by giving it the look of real film. It 

does this by emulating the entire photochemical process (original film 
negative, Color grading, and Print stock). For example, you can give your 
film a vintage look or make the colors more vivid (figure 6)

You start by specifying if your footage is Video, Flat, or Log. After that 
there is a drop-down menu that lists 22 different Negative Stock types  
(Kodak 5201 Vision 50D, Fujifilm F125, Prolostia P2100, etc.) for you to 
choose from. Every time you select one of the Negative types, your footage takes on a different appearance. There are also two Kodak and two 
Fujifilm Print Stocks you can choose from. All totaled, it has 88 possible cinematic combinations that you can choose from. 

If your chosen film look is close, but not quit the look you want, you can tweak it further by using one or more of the slider controls for Tint, 
Exposure, Saturation, Skin Tone, Grain, Vignette, etc.

If you would like to see Magic Bullet Looks being used, please click on this link to the Magic Bullet film “Getting Started” video.

Mojo
Mojo is designed to instantly give your footage the stylized color grade of a Hollywood blockbuster. In other words, it accentuates skin tones plus 

it helps protect the skin tones to keep your skin looking natural even when you push the colors into the shadows. It can also be used to cool the 
background.

There are 15 presets for Magic Bullet Mojo that range from Mojo, Light, and Mucho to War, Noir, and Handmade (Figure 7). Selecting any of 
these will instantly change the overall look of your footage. If one of these presets are close to the look that you want but not perfect, you can also use 
the control sliders to tweak your footage further. These sliders give you options to: Punch it, Fade it, Bleach it, Vignette It, Exposure, Cool/Warm, 
Skin Yellow/Pink, etc. There is even a “Show Skin Overly” option that will place an orange grid over any part of your footage where the hue is in a 
correct range for Skin Tone. There is also a “My Footage is” pull-down menu which lets you choose whether you footage is from Video, Log, Flat, 
or Pro. This helps Mojo/you to get started with the color grading.

If you would like to see Magic Bullet Mojo being used, please click on this link to the Magic Bullet Mojo “Getting Started” video.

Cosmo II
Cosmo II improves the look of your male and female actors by tweaking their 

skin tones, reducing wrinkles, and removing skin blemishes. So you can take your 
actor’s bumpy, splotchy, freckled face and smooth it out to make her look more 
beautiful or him more handsome (Figure 4).

Some of the tools are the same as with Mojo, but Cosmo II has a few different 
tools, such as: Skin Smooth, Preserve Detail, Preserve Contrast, Sharpen Texture, 
Restore Noise, and Auto Color. As with Mojo, Cosmo II also has the Show Skin 
Overlay option that places a grid on the the areas that it thinks is your actor’s face. 
You can use this to confirm that the skin is the only thing selected so you can be sure 
that you are editing your subject and not your background. 

If you would like to see Magic Bullet Cosmo being used, please click on this link 
to the Magic Bullet Cosmo II “Getting Started” video.

Figure 6. This screenshot shows Magic Bullet Film being 
applied to the right half of the screen. Notice how the 
haze is gone and the colors are more vivid.

Figure 5. Colorista’s Keyer can be used to isolate colors or ranges 
of colors so you can change just that color in your clip, such as 
changing the yellow on this scooter to blue. 

http://www.redgiant.com/products/magic-bullet-looks/
http://www.redgiant.com/products/magic-bullet-looks/
http://www.redgiant.com/tutorial/magic-bullet-film-quickstart-guide/
http://www.redgiant.com/tutorial/magic-bullet-film-quickstart-guide/
http://www.redgiant.com/tutorial/magic-bullet-mojo-ii-quickstart-guide/
http://www.redgiant.com/tutorial/magic-bullet-mojo-ii-quickstart-guide/
http://www.redgiant.com/tutorial/magic-bullet-cosmo-ii-quickstart-guide/
http://www.redgiant.com/tutorial/magic-bullet-cosmo-ii-quickstart-guide/
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Denoiser III 

Frequently when you film at high ISO’s or low-light locations, your 
footage will wind up with a lot of noise or graininess. Denoiser III will 
remove this unwanted noise grain and artifacts from your video clip while 
leaving the details intact. Some of the tools:
• The Reduce Noise slider lets you choose how much noise that you do or 

don’t want to see in the footage - keeping in mind that you don’t want 
to reduce the noise so much that you lose the image detail.

• The Smooth colors slider lets you target color noise found in 
your footage and will work to blend that noise together.

• The Preserve Details slider lets you bring back detail that may 
have been lost during the noise reduction.
If you would like to see Magic Bullet Denoiser III being used, please click 

on this link to the Magic Bullet Denoiser III tutorial video.

Renoiser
Renoiser is the opposite of Magic Bullet Denoiser III. Instead of reducing the noise in your footage, Renoiser can add cinematic texture and grain 

to your digital footage.
Renoiser actually rebuilds your image out of virtual grain rather than just applying a grain layer on top. This produces a result in real time.
Renoiser is fully-customizable and Includes 16 noise/grain presets based on real film stocks and popular movies, such as 16MM, 8MM and much 

more. It also comes with 16 slider controls that you can use to manually customize the look of your footage.
If you would like to see Magic Bullet Renoiser being used, please click on this link to the Magic Bullet Renoiser “Getting Started” video.

The Skinny
Evaluation: The Magic Bullet Suite tools and presets are a quick way of changing the look or mood of your clip. I was very impressed with all of the 

different parts of this suite. I think any filmmaker would find these an invaluable addition to his/her video editing tools. 
Requires:  

Mac: Intel Mac running Mac OS X 10.10 or later; PC: Windows 7, 8, 10 (64-bit)
Host: Final Cut Pro X, Motion 5, Premiere Pro, After effects, plus some of the tools also work in additional host-applications. Since Magic 
Bullet Suite is made up of different tools that have their own compatibility requirements, I suggest that you go to the Magic Bullet Suite 
Compatibility web page to see if your computer can run all of the parts of Magic Bullet Suite.  

Company: Red Giant
Price: Magic Bullet Suite: $899  (this is a savings of $394 over the individual prices - see below); Academic Price: 50% off regular store prices

Individual Plug-in PricingIndividual Plug-in Pricing

Magic Bullet Looks $399

Magic Bullet Colorista IV $199

Magic Bullet Film $199

Magic Bullet Mojo $99

Magic Bullet Cosmo II $99

Denoiser III $199

Renoiser $99

Total if bought separately $1,293

Magic Bullet Suite price $899

Figure 7. This shows how a clip would look with different Mojo 
presets applied.

http://www.redgiant.com/tutorial/magic-bullet-denoiser-iii-quickstart-guide/
http://www.redgiant.com/tutorial/magic-bullet-denoiser-iii-quickstart-guide/
http://www.redgiant.com/tutorial/magic-bullet-renoiser-quickstart-guide/
http://www.redgiant.com/tutorial/magic-bullet-renoiser-quickstart-guide/
http://www.redgiant.com/products/magic-bullet-suite/compatibility/
http://www.redgiant.com/products/magic-bullet-suite/compatibility/
http://www.redgiant.com/products/magic-bullet-suite/compatibility/
http://www.redgiant.com/products/magic-bullet-suite/compatibility/
http://www.redgiant.com
http://www.redgiant.com
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Airy
by L. Davenport

Has there ever been a time when you wanted to have a copy of a YouTube video so you can view it while off-line, but you had no way to copy it? 
Well now you can if you use Eltima Software’s Airy.

Airy has a streamlined appearance. 
There is a small window that has a 
URL text field, a format/resolution 
dropdown menu and a download 
button (Figure 1 & Figure 3).

When you find a YouTube video 
that you want to download, you simply 
have to copy the video’s URL and then 
paste it into Airy’s URL text field. Airy 
will automatically open that URL and 
then look for the video on that page. If 
the video is part of a playlist, Airy will 
ask if you want to download the entire 
playlist or only the single video (Figure 
2). 

If you choose to download the 
playlist, Airy will scan the whole playlist 
and then display the number of “Links” 
(videos) that it found (Figure 3). At this 
point, you can select the resolution that 
you want the videos saved as and then 
click the Download button. It couldn’t be simpler. Airy 
will display each title in the playlist as it proceeds to 
download them (Figure 4). FYI: Airy can also download whole 
YouTube Channels (Figure 6) plus it supports video formats from 
MP4’s all the way up to 8K Ultra HD videos. Airy can also download 
MP3 audio tracks taken from the YouTube videos.

Airy gives you the option to “Log into YouTube”. This is required 
if you want to download age restricted videos.

Browser Integration
Airy can be integrated into most of the popular browsers: Safari, Chrome, Firefox, or Opera. Setting up the 

browser integration is very simple. All you have to do is click on Airy’s “Integrate into Browser” menu option. 
Seconds later your browser will open and then go to a web page that has the Browser Integration button/script. All 
you have to do is copy it to your browser’s Bookmark Bar at the top of the browser window (Figure 5).

Once Airy is integrated into your browser and you find a video that you want to download, you simply click on the “Open in Airy” bookmark. 
Instantly Airy is opened so the download can proceed.

The Skinny
Evaluation: Airy is a simple but efficient program for downloading YouTube videos and audio. I especially like the ability to download whole 
playlists.  This is a real timesaver if the playlist is very long (versus having to manually click the Download button for every video in the playlist).
Requires: MacOS 10.7 or higher including MacOS 10.12 (Sierra)
Company: Eltima Software
Price: $19.95
Available Trial FYI: Trial version doesn't feature adding multiple links at a time and will download first two items of a YouTube playlist or channel.
Disclaimer: Neither L. Davenport nor SMMUG is endorsing downloading online videos. This review is only telling you the capabilities of the Airy program. 

Figure 2. Tell Airy whether you are down- 
loading a single video or a whole Playlist.Figure 1. Copy the YouTube URL from your browser 

and then paste it in Airy’s URL text field.

Figure 4. Airy will (one after the other) 
download the videos to the location that you 
previously select in the Airy preferences.

Figure 3. Airy will list the number of 
Playlist links that it finds. Afterward, 
select the quality/format of the video 
you want saved and then click the 
Download button.

Figure 6. You can integrate 
Airy into your browser by 
dragging the red “Open in 
Airy” button/bookmark to 
the browser’s Bookmarks 
Bar.

Figure 5. Airy can download whole 
YouTube channels.

http://mac.eltima.com/mac-products.html
http://mac.eltima.com/mac-products.html
http://mac.eltima.com/youtube-downloader-mac.html
http://mac.eltima.com/youtube-downloader-mac.html
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Annotating Documents and Images
by Adam C. Engst  and Josh Centers

The last time we explored Preview, OS X’s built-in document and image viewer, we discussed using it to crop and resize images, as well as how to 
undo those changes (see “The Power of Preview: Cropping and Resizing Images,” 18 March 2016). Although Preview has many more image 
manipulation tools, we’re focusing this week on Preview’s annotation capabilities, which you can use to mark up an image or PDF (you can’t 
annotate Microsoft Office or iWork documents).

Most of Preview’s annotation tools are available in 
the Tools > Annotate menu, but it’s often easier to 
find them in the Markup Toolbar, which you can 
display by clicking the toolbox icon on the main 
toolbar, or by choosing View > Show Markup 
Toolbar (Command-Shift-A).

The Colour and the Shape -- The Preview 
annotation tool we use most often is Shapes, which 
makes it easy, for instance, to call out a particular 
interface element in a screenshot. You can find all available shapes under Tools 
> Annotate > Rectangle, Oval, Line, Arrow, Polygon, and Star. However, it’s 
usually faster to access Shapes on the Markup Toolbar.

Whether using the menu or toolbar, choose a shape to insert it into your 
document or image. It appears in the center of your document; to insert a new 
shape at a particular spot, click Shapes on the Markup Toolbar, and then drag 
the desired shape to the spot you want.

A selected shape is surrounded by blue drag handles you can use to adjust the 
shape’s dimensions. As in 
m a n y i m a g e 
manipulation apps, you 
can press Option while 
dragging a handle to resize 
from the center, and press 
Shift to maintain the 
shape’s aspect ratio. For 
lines and arrows, the Shift key constrains the line to 45-degree angles.
  You can, of course, move the shape, by placing your cursor on the shape anywhere other than 
on a drag handle — when your cursor becomes a hand, click and drag to move the shape. Or 
just click once to select the shape, after which you can use the arrow keys to nudge it more 

precisely.
As is often the case, if you need more than one shape of the same type, you can either use copy and 

paste, or simply hold down Option and drag the shape, as if to move it, to create an exact duplicate.
The line, polygon, and star offer additional possibilities. When first inserted, lines are straight, but a 

green drag handle in the middle of the line lets you make it into a smoothly curved line. By default, 
inserting a polygon adds a hexagon to your document. But if you select it and look closely, you’ll see 
another green drag handle. Move that handle counter-clockwise to remove sides, down to three, or 
clockwise to add sides, up to 12. The star shape works similarly, except it has two green handles, one 
that adds or remove points and another you can use to change the length of the points. For both the 
polygon and the star, the Shift key’s behavior is reversed; the resizing handles maintain aspect ratio by 
default, and the Shift key lets you change the horizontal and vertical dimensions independently.

The Power of Preview

http://tidbits.com/article/16339
http://tidbits.com/article/16339
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It’s possible to rotate a shape, too, but only if you have a trackpad. Select the shape, put your 

thumb and forefinger on the trackpad, and twist. Make sure you have a shape selected first, 
because otherwise Preview rotates the entire image (in 90-degree increments).

After adjusting the shape, size, and position, you can further customize the shape’s look with 
options on the Markup Toolbar:
• Shape Style: Use this menu to adjust the thickness of the shape’s exterior line, generally called 

the “stroke.” You can also make the stroke dashed or rough-drawn, as well as add or remove a 
drop shadow. For line and arrow shapes, you can also choose where to place arrows.

• Border Color: Click this button to display a color picker that lets you adjust the color of the 
shape’s stroke.

• Fill Color: Similarly, this button reveals a 
color picker that lets you adjust the color of the 
“fill” — the space inside the stroke. By default, 
it’s set to “no fill,” signified by a red line across 
a white square.
 There are a few ways to use these tools in 
constructive ways other than inserting pretty shapes. A technique we use frequently at TidBITS 
and Take Control is to place a red oval or rectangle with no fill around interface elements we want 
to draw attention to. Even if you’re not a technology writer, snapping a quick screenshot (which 
you can do from within Preview, as you learned in “The Power of Preview: Pulling Files into 
Preview,” 25 February 2016), highlighting an onscreen item, and sending the annotated 
screenshot to a friend can save time and frustration when trying to assist with a technical issue. 
Arrows can also be useful for pointing out specific details.
Shapes can also be helpful for redacting text from PDFs that you’re planning to print. Create a 
rectangle with a black stroke and a black fill and drag it over a portion of a document you wish to 
obscure. When you print the document, the black rectangle will cover the sensitive material. (Josh 
once had a job that involved doing this for thousands of documents, albeit not with Preview.) 

Don’t assume this technique will work for PDFs you’re distributing digitally; the shapes remain editable objects that can be moved and deleted in 
both Preview and Adobe Reader. For a true redaction capability that deletes the text underneath the black bar, use Smile’s PDFpen or Adobe’s 
Acrobat Pro.

Preview remembers your settings, so if you generally want shapes with 3-point red strokes and no fill, you’re all set. Unfortunately, there’s no way 
to save different settings, so if you switch to a black rectangle, reverting to your previous settings must be done manually.

With PDFs, annotations remain unique, editable objects, even after you save, close, and re-open a document. However, with images, that’s not 
true. Once you close an edited image, all your annotations are flattened into the underlying bitmap of the image and can no longer be selected and 
manipulated individually. In other words, make certain that you’re done adjusting annotation shapes before you close the file.

One final tip here. You might think that you could use Edit > Select All (Command-A) to select all the annotations you’ve made and delete them. 
You’d be wrong; that selects all the previously existing picture content 
instead. However, you can Shift-click multiple objects to select them 
simultaneously for moving or deleting all at once.

Who Was That Masked Loupe? -- For an alternative way to call 
things out, check out the Mask and Loupe shapes, both available from 
View > Annotate and the Shapes button menu in the Markup Toolbar.

Mask is a bit tricky to use because it’s sort of a reverse shape: the actual 
shape is a large gray border that deemphasizes what it covers. Inside that 
border is a “no fill” rectangle that you position over the portion of the 
image you want to highlight. The blue drag handles work as you’d 
expect, but to select or move the rectangle, you must click outside it, not 
inside, like every other shape. Play with the mask shape on a throwaway 
image so you can get a sense of how you might use it.

Loupe inserts an onscreen magnifying glass, which is a helpful way to 
highlight small details, but it also distorts the image, which can be 
confusing to the viewer. You change the size of the loupe with the blue 

http://tidbits.com/article/16284
http://tidbits.com/article/16284
http://tidbits.com/article/16284
http://tidbits.com/article/16284
https://smilesoftware.com/pdfpen
https://smilesoftware.com/pdfpen
https://acrobat.adobe.com/us/en/products/acrobat-pro.html
https://acrobat.adobe.com/us/en/products/acrobat-pro.html
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drag handle and adjust the zoom level with the green drag handle.

The Pen Is Mightier -- If you’d rather draw shapes yourself, Preview lets 
you do that. In the Markup Toolbar, the third button from the left activates 
the Sketch tool, which doesn’t appear to have a menu equivalent. Select it, and 
click and drag to draw the desired shape.

What Preview does next depends on what you drew. If Preview thinks you 
were trying to draw a square, for instance, it changes your drawing to be a 
proper square shape. Likewise with triangles, ovals, lines, arrows, and other 
shapes — it’s a loose interpretation. Usually, if you draw an unidentifiable 
squiggle, Preview will leave the squiggle as is, but its behavior isn’t always 
predictable.

Thankfully, if you don’t care for Preview’s interpretations, or if Preview couldn’t see that you meant to 
draw a dialog balloon, you have a chance to correct it. After drawing a shape, look closely at the upper left 
of the window, where a small popover appears with your original and a choice of possible replacement 
shapes. Click the one you want, but be aware that you get only one shot, since the popover vanishes 
forever after you choose, or if you deselect the shape.

If you happen to have a trackpad equipped with Force Touch, note that the Sketch tool is 
pressure-sensitive, so you can press more firmly to darken the line as you draw.

The Sketch tool can be useful in ways you might not expect. For instance, imagine that you’re trying to 
give someone directions on a trail. Bring up the area in satellite view in Google Maps, take a screenshot, 
and then use the Sketch tool to draw a freehand line indicating where to go.

Texting While Annotating -- Shapes are great, but what about when you want to add a description to 
an annotation or complete a PDF form that lacks interactive form fields? For that, you can insert text. 
And, not surprisingly, Preview offers quite a few ways to do so.

The main way to insert text is to choose Tools > Annotate > Text (Command-Control-T) or click the 
Text button in the Markup Toolbar. Preview inserts a text box, with “Text” as a placeholder. You can move and resize this text box just as you would 
a shape, although it can be a little fussy, since clicking inside the text box edits the text instead of grabbing the box. Try these techniques to make 
moving it easier. First, click anywhere else to deselect the text box, hover over the deselected text box until you see the hand cursor, and then click 
and, without letting up, drag. Second, if the text box is already selected, hover over the outlined edge to get the hand cursor and drag.

To change a text box’s typeface, point size, color, style, and alignment, select the text box and click the Text Style drop-down menu in the Markup 
Toolbar, which is the rightmost button. You can’t style individual words or characters in the text box separately.

You can also use the Shape Style, Border Color, and Fill Color 
menus to further customize the look of the text box, just as you can 
with shapes. Border Color lets you add a border to the text box and 
give it a color, Shape Style offers stroke thickness and style choices, and 
Fill Color adds a background color to the text.

For more fun, try speech bubbles, which you insert by choosing 
Tools > Annotate > Speech Bubble or from the Shapes button in the 
Markup Toolbar. They work just like regular shapes, with the addition 
of two green drag handles for controlling the tip and base of the arrow. 
They can be fun for snapshots, but we’d caution you against using 
them in professional documents.

In fact, although it’s not inherently obvious, you can actually add 
text to any of the shapes, including lines and arrows. For those two, 
the text appears off to one end of the line; for the rest, the text shows 
up inside the shape.

Take Note -- In “The Power of Preview: Viewing Images and 
PDFs” (13 March 2016), we discussed highlighting text in PDFs and 
adding notes to your highlights. That’s all fine and nice, but what if 
you want to leave a comment that’s not associated with text? For that, 
Preview lets you insert free-floating notes, which are represented by 
small yellow squares that only coincidentally resemble Post-it® sticky notes. (You can’t insert notes into images.)

http://tidbits.com/article/16323
http://tidbits.com/article/16323
http://tidbits.com/article/16323
http://tidbits.com/article/16323
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To insert a note into a PDF, choose Tools > Annotate > Note 

(Command-Control-N) or click the Note button in the Markup 
Toolbar. Preview adds a small yellow square to the center of the current 
page, popping out a larger yellow rectangle into which you can type text. 
Enter as much text as you want; the yellow rectangle expands to hold it. 
Click anywhere outside the yellow rectangle to close it, leaving just the 
little yellow square.

There are five things you can do with the square after clicking to select 
it:
• Click it again to open it for editing.
• Move it next to the portion of the page on which you’re commenting, 

which is usually a good idea.
• Option-drag it to make a copy; this could be helpful if you need the same comment applied to multiple spots on the page.
• Use Copy and Paste to put it on another page. Cut works too, if you created the note on the wrong page.
• Press Delete to remove it from the document.

Remember that you can navigate to these notes in the sidebar, by 
choosing View > Highlights and Notes. Plus, you can add text to the 
notes in the sidebar, or edit them there, which is often easier than 
opening and closing the editing rectangle.

Sign on the Dotted Line -- Here’s a classic problem: someone sends 
you a form to sign via email. You have to print it, sign it, and then scan 
it back into the computer so you can email it back (or, horrors, fax it). 
Preview solves this problem neatly with its signature feature, found in 
Tools > Annotate > Signature, but more easily accessible in the Markup 
Toolbar. It enables you to create one or more signatures, and then easily add them to images and PDFs.

There are two ways to create a digital signature: by scanning a handwritten signature 
with the Mac’s webcam or by writing it on the trackpad. Obviously, if all you have is a 
mouse, you’ll want to use the camera method.

To create a signature with a trackpad, click the Sign button in the Markup Toolbar 
and choose Create Signature. Click the Click Here to Begin button and write out your 
signature on the trackpad with your finger — if you have a capacitive stylus for an iPad 
(not an Apple Pencil), it will likely work better. There’s no way to erase, so if you’re 
unhappy with the results, click Clear and try again. When you’re satisfied, click Done 
to add the signature to Preview’s list.

However, using a webcam like the FaceTime camera built into most Macs is 
arguably the better way to 
make a signature. Sign 
your name on a blank, 
white piece of paper, 
preferably with a black 
marker. Choose Create 
Signature and click the 
Camera button. Inside the 
popover, a window 
appears displaying what 
your camera sees. Hold your paper signature up to the camera, making sure to get it 
close and lined up with the blue line. When Preview detects the signature, it displays the 
digital version in the camera window. Again, if you don’t like the results, click Clear and 
try again, or if you’re happy, click Done to save the signature.
Once created, your signature is easy to insert into an image or PDF. Choose Tools > 
Annotate > Signature or click the Sign button again. This time, you’ll see your new 
signature there. Choose it to insert it into the document, where you can move and resize 
it like any other shape. You can also adjust its color by modifying the Border Color 
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settings, although signatures can’t use the Fill Color option.

Although we’re not suggesting illegal forgery, if you find 
yourself in a situation where you often need to sign things for 
your boss or for an incapacitated relative, getting that person’s 
signature into Preview can make signing electronic forms for 
them much easier.

Once you save the PDF, the signature is embedded into the 
PDF’s visual layer, so it can’t easily be copied out and reused. Of course, someone could extract it by taking a screenshot of it in the PDF, but they 
could also scan or photograph a paper document to get the signature, so there’s no real difference in security either way.

Note that these signatures will sync to other Macs if you have iCloud Keychain turned on in System Preferences > iCloud > Keychain, and you 
can use your signatures when marking up images in Apple Mail.

We’ve now shown you how to use Preview to open and import files, efficiently view images and documents, crop and resize documents and 
images, and annotate documents and images. But it will be another few articles before we’re done — stay tuned for more on the power of Preview!

Tidbits
Responding to Complaints, Apple Drops Adapter and Monitor Prices

by Josh Centers
Many Apple fans have been irked by how the new line of MacBook Pro laptops offers only Thunderbolt 3 ports (which are backward compatible 

with USB-C). To connect to existing peripherals, users will require one or more adapters, such as those for USB-A, DisplayPort, HDMI, Ethernet, 
and even older implementations of Thunderbolt. See “Explaining Thunderbolt 3, USB-C, and Everything In Between” (3 November 2016) for 
a thorough explanation.

Apple doesn’t get any points for thinking ahead, but happily, the company does appear to be responding to the waves of criticism. According to 
the Loop, Apple is dropping prices on many of its adapters through the end of 2016. Affected products include:
• USB-C to USB Adapter: from $19 to $9
• Thunderbolt 3 to Thunderbolt 2 Adapter: from $49 to $29
• USB-C to Lightning Cable (1m): from $25 to $19
• USB-C to Lightning Cable (2m): from $35 to $29
• USB-C Digital AV Multiport Adapter: from $69 to $49
• USB-C VGA Multiport Adapter: from $69 to $49

Apple is also discounting other USB-C products sold in the company’s online store, such as the SanDisk Extreme Pro SD UHS-II Card USB-C 
Reader, which drops from $49 to $29.

If you purchased any of these adapters in the past 14 days — 
Apple’s return window — the company may automatically credit 
you for the difference in price; Adam Engst got email from Apple 
about that after the initial publication of this article. If you don’t hear 
from Apple in a few days, I recommend calling them and asking for a 
partial refund. I did that and obtained a $30 refund for my USB-C to 
USB Adapter and my Thunderbolt 3 to Thunderbolt 2 Adapter.

MacRumors reports that Apple has also cut the price of the LG 
UltraFine 5K Display, which it developed with LG, from $1299 to 
$974 until the end of 2016. Also, Apple slashed the price of the LG UltraFine 4K Display from $699 to $524. The 5K Display isn’t yet available for 
sale but should launch in December 2016.

Apple could have avoided the entire hullaballoo by including an adapter or two in the box with new MacBook Pros or giving customers the option 
to receive the adapter of their choice for free when ordering. Instead, Apple came off as trying to nickel-and-dime its most eager customers, who were 
already spending significant sums on the company’s latest gear. And even still, dropping the prices only through the end of 2016 seems stingy, given 
that Apple’s adapters and cables are almost always the most expensive by far.

http://tidbits.com/article/16870
http://tidbits.com/article/16870
http://www.loopinsight.com/2016/11/04/apple-cuts-prices-on-usb-c-adapters-and-accessories/
http://www.loopinsight.com/2016/11/04/apple-cuts-prices-on-usb-c-adapters-and-accessories/
http://www.loopinsight.com/2016/11/04/apple-cuts-prices-on-usb-c-adapters-and-accessories/
http://www.loopinsight.com/2016/11/04/apple-cuts-prices-on-usb-c-adapters-and-accessories/
http://www.macrumors.com/2016/11/04/apple-lg-display-major-price-cut/
http://www.macrumors.com/2016/11/04/apple-lg-display-major-price-cut/
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Amazon’s Package X-Ray Lets You Peek Inside Boxes

by Josh Centers
In this modern world, it’s all too common to be inundated with 

nondescript cardboard boxes arriving from Amazon in the weeks leading 
up to the holiday gift-giving season. Typically, I cut the boxes open, see 
what’s inside, and seal them back up before wrapping and labeling them. 
But Amazon has introduced a brilliant new feature to the Amazon iOS 
app: Package X-Ray, which lets you peek inside unopened packages 
from the company. Unfortunately, it only works in the United States for 
now.

To use it, open the Amazon app (make sure you’re logged in), tap the 
camera icon, and then quickly tap Package X-Ray. By default, the 
camera tries to identify objects and search for them on Amazon; it does 
this quickly, so you may have to swipe down on those search results to 
switch to Package X-Ray.

Once you’re in Package X-Ray mode, scan the shipping label on an 
unopened Amazon box, and a bubble should appear showing a 

thumbnail of the item inside. If the package contains multiple items, 
you’ll see a bubble for each. Tap a bubble to go to the product listing.
There are a few small caveats. First, Package X-Ray won’t work if you’ve 
split the shipping label by opening the package, even if you press it back 
together — but if it’s already open, you don’t need the feature anyway.
Second, Package X-Ray works only with packages tied to your Amazon 
account, so no curious children, spouses, or delivery people can spy on 
what you’ve bought. That also means you won’t be able to identify 
what’s in boxes sent to you — even when that would be entirely 
appropriate — by relatives who are shipping gifts directly to your address 
in advance of their holiday visits.
Those who do a lot of gift shopping on Amazon may find Package 
X-Ray helpful. Whether or not you would wrap an unopened box like 
me, it’s still handy to be able to peek inside an otherwise unidentifiable 
box without having to open it first.

Responding to Complaints, Apple Drops Adapter and Monitor Prices -- People are angry about all the adapters required for the new line of 
MacBook Pro laptops, but thankfully Apple is temporarily reducing prices on those adapters and the LG 4K and 5K monitors.

Explaining Thunderbolt 3, USB-C, and Everything In Between -- The new MacBook Pro laptops are the first Macs with Thunderbolt 3, a 
standard that uses the USB-C plug style and retains USB compatibility. But what’s most interesting about Thunderbolt 3 is how it supports 
numerous other protocols, including USB, Thunderbolt 2, FireWire, DisplayPort, and Ethernet, with the addition of appropriate adapters.

Feed Hawk Is Useful But Not Essential for RSS Junkies -- The iOS app Feed Hawk helps RSS users subscribe to their favorite sites with ease. 
The app is far from indispensable, however, with the emergence of other RSS tools for the iPhone and iPad.

A Prairie HomeKit Companion: Core Concepts -- Interested in home automation with HomeKit, but don’t know where to start? Josh Centers 
kicks off a series about HomeKit, starting with its fundamental concepts.

https://itunes.apple.com/us/app/amazon-app/id297606951?mt=8&at=10l5PW
https://itunes.apple.com/us/app/amazon-app/id297606951?mt=8&at=10l5PW
https://itunes.apple.com/us/app/amazon-app/id297606951?mt=8&at=10l5PW
https://itunes.apple.com/us/app/amazon-app/id297606951?mt=8&at=10l5PW
http://tidbits.com/article/16888
http://tidbits.com/article/16888
http://tidbits.com/article/16870
http://tidbits.com/article/16870
http://tidbits.com/article/16865
http://tidbits.com/article/16865
http://tidbits.com/article/16843
http://tidbits.com/article/16843
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HOW TO FIND US
General meeting:
SMMUG General Meetings are held on the SECOND Monday of 
each month at Fire Station 14 located at 1875 Dublin Blvd (at the 
intersection of North Academy and Dublin). 

Directions:
From Academy, go east on Dublin and then turn right on 
the very first street. There is parking on the west and south 
sides of the Fire Station (with additional parking located to 
the north and further west of the Fire Station). The entrance 
is on the west side of the building.

Smoking is not permitted on the premises. 

Sig meeting:
The SIG Meetings are held on the SECOND Saturday of each month at Fire Station #18’s meeting room - located at: 6830 Hadler View 
[the fire station is behind Walgreens]. 

Directions:
#1) Take I-25 to Garden of the Gods Rd (head west), turn right on Centennial, left on Flying W Ranch Rd., right on Hadler View.
#2) (This route is bumpier and probably not the best for winter travel) Take I-25 to E. Woodman/W. Rockrimmon Blvd., turn right on Vindicator 
(at the Safeway intersection), and then right on Hadler View.
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Membership Application Form
Membership entitles you to access to our online forums, participation in prize drawings, and access to the 
bargains in the members area of the SMMUG website at www. smmug.org. SMMUG renewal membership dues 
($25) apply to the calendar year and are paid each December for the following year. Use the following table for 
NEW MEMBERSHIP ONLY:

 JAN 1 to MAR 31 - $25.00  APR 1 to JUN 30 - $21.00
 JUL 1 to SEPT 30 - $14.00  OCT 1 to DEC 31 - $7.00

Please Print Clearly!     Today’s Date 

Name
 Street Address

 City/State/ZIP
 Home Telephone

 E-mail Address
Have you previously been a member of SMMUG?
How did you learn about SMMUG?

Make your check payable to:  SMMUG  
Then mail or give this form and your check to:

SMMUG, Inc. 
Skip Mundy, Treasurer   
PO Box 62741 
Colorado Springs, CO   80962 

Please make an online account for me.
User Name _______________

Don’t make an online account for me. 
I do not want one or I already have 

Business Telephone 

About Us

The Silicon Mountain Macintosh User Group, Inc. (a nonprofit educational corporation) was formed in Colorado Springs, 
Colorado in 1985, and is one of the oldest Macintosh User Groups in the United States. SMMUG, Inc. is dedicated to helping 
members enjoy and learn about their Macintosh computer, iPhone and iPad devices.

Club membership is open to everyone and you are cordially invited to visit our free monthly General Meeting on the second 
Monday of each month, at 7:00 PM. For those new to the Macintosh, we have a Question & Answer session at 6:00 PM, where 
our collective expertise can help answer your questions. 

All members receive a monthly newsletter, published on our web site, see great reviews of software and hardware, or can 
participate in the monthly door prize drawing. Each member gets one vote during annual Officer Elections. No corporate 
memberships are granted.

Our officers are volunteers and receive no pay. All funds raised are used for the cost of operating the club and its meetings.

http://www.smmug.org
http://www.smmug.org

